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1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a couple
of minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the
Getting Started window appears, click I have used it before! (or you will just end up back
on this page). You should now see the main window.

L L ] Easy Data Transform 1.4.0 {free trial)
DBEB0JQA&a # ® vrwor
¥ Input

From Filg 0]

Fromm Clipboard  (F)

Add data you want to transform by:
- dragging data files here; or
= clicking the 'From File' or 'From Clipboard® buttons

[ Email us questions/fesdback
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Drag a data file you want to transform onto Easy Data Transform. Any sort of table or list
should be fine. For example a .csv file or an Excel .xIsx/.xls file.

- [ ] Easy Data Transform «1.4.0 (free trial)
DBE 0 QA& S # @ 7Hwor
= Input testl.csv @[5
From File @ . . . File: [UsersfandyhfDeskiop/test] cov
Froem Clipboard  (7) watch file
= Transtorm Delimiter:  Automatic L]
All Fanstorma 0 Encoding: Automatic o
Case @ ’ lgnore; First O rowis) -
. + has header
1 (7
chop @ ¥ trim whitespace
Clang & + simplify whitespace
— + ignare empty rows
Compare Cols _ (2) Alias: test]
concatcols  (F) Camment:
Copy Cols A
2 C||% & Show first 10 ows &
Count o)
- v testl.csv ) lite  first mame  lastname  suMfix  display name
s 23 esls » 64 rows i M Andrew  Adams Mr Andrew Adams
Date Format L),
2 Mirs  Nikki Adams Mrs Nikki Adams:
Dadupe @'
. 3 Ms Rose Atwall Ms Rose Atwell
Extract &
. @ 4 Me  Colin Ayer Mr Colin Ayer
Firter @ 5 Mrs Michelle Blaire Mrs Michalle Blaire
Gathar o] & Mr  Simon  Blaire Mr Simon Blaire
" = N 7 M Albert Brown Mr Albert Brown
ranrt & 8 Mz Cynthis  Brown Mrs Cynthia Brown
o) 9 Miss Jane Brown Mrs Jane Brown
dwvaszrint (D) . 0 Mr Dawld  Burgess Mr David Burgess
®

=] Email us questions/fesdback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header.
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testl.csv ¢

File: /Users/andyb/Desktop/testl.csv
watch file

Delimiter: Automatic

Encoding: Automatic

L

Ignore: First O row(s)
has header
ace
simplify whitespace
ignore empty rows

Alias: testl
Comment:
Cl B & Show first 10 rows |
<:title first name | last name  suffix  display name )
1 Mr Andrew  Adams Mr Andrew Adams

All the transforms available for a single dataset are now enabled in the Left pane. Hover
over the transforms to see tooltips explaining what they do. Click on the ? next to a
transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.
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‘soe Easy Data Transform vw1.4.0 (free trial)

DBEEO0QQAHE rumomr
v Input
From File (0]

Froem Clipboard  (F)

All ransforma

Casie
Chop &
Clane &

Compare Cols (7}

concatcols  (F)

Copy Cols @

Count @
® ' &

Date Format LA}

testl.csv

1} eods x 64 rows

Dedups i)
Extract I:Z)
Fill @
Eilter .:_r)
Gathar @

" .'?. .
ranr &
@

Javascript @ .
@

A Case transform item will now be added.

‘@ L ] Easy Data Transform ¥1.4.0 {free trial)

DBEEO0QAaa#FER rwnr
o Input
From File @

From Clinboard  (F)

hd Transform

All ransforma =
Case @
Shap &
Gione @

Compare Cols  (7)
Concai Cols {'—_h
CegyCols ()
Count @
® ' g

Date Format LA}

testl.csv

22 ool % B4 rEWE

Dadupe (?::
Extract l:z)
Fill &
Eilter .:_r:l
Gather (::".

1 (':5‘:
il @&
@

Jmvseript ()
@

Easy Data Transform

testicsy D52
File: MUsersiandybiDeskiop/fiest].cov
watch file
Dielimiter:  Automatic
Encoding: Automatic E
Igniare: First O rowis) =
has header
trim whitespace
simplify whitespace
ignare empty rows
Alias: test]
Carnmet:
C||% & Show first Wrows [
tithe  first rama | lastname  suffic | display name
1 L Andrew  Adams Mr Andrew Adams.
2 WS Mikki Adams Mrs Nikki Adarms
3 Ms Rose Atwell Ms Rose Atwell
4 Me  Colin Aol Mr Colin Ayer
5 Mrs  Michelle Slairg Mrs bichelie Blairg
8 M Siman [Blaire Mr Simon Blaire
7 Mr  Albert Brown Mr Albert Brown
@ Mz Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane Brown Mrs Jane Brown
10 M David Burgess Mr David Burgess
] Email us questionsffesdback
LT
wu
Q, Fifter calurm
title
first name:
last name
uffix
0 of 22 columns selected
Change case 10;  Lower Case E

Comment:
Change the case in the selected column(s).

G B & Show first 10 rows

tithe  first rame  lastname  suffic  display name

1 iy Andrew  Adams Mr Andrew Adams.
2 Mirs  Nikdki Adams Mrs Nikki Adams
3 Ms Rose Arwell Ms Rosa Atwell

4 M Colin Aper Mr Colin Ayer

5 Mrs Michelle Blaire Mrs Michalle Blaire
& Mr Simon  Blaire Mr Siman Blaire

7 M Albert Brawn Mr Albert Brawn

8 Mrs Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane [Brawn Mrs Jane Brown

0 M Dawig [Burgess Mr David Burgess

Last 54 raws nol shawn

] Email us questionsffeedback
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In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case.

KA
Case ¢

ElE 'Q Filter columns

I title I
Irst name

last name

suffix

il o i it i

1of 22 columns selected

Comment:

Change the case in the selected column(s).

6 B & Show first 10 rows &)

title  first name | last name | suffix | display name

1 | MR Andrew  Adams Mr Andrew Adams

2 | MRS | Mikki Adams Mrs Mikki Adams

You can create a sequence of transforms to perform complex manipulations.

Case Dedupe Sort

J o

39 calls x 50 now s

IJ testl.csy

o

33 cols x50 raws 339 mls x 50 raws. 39 cok ¥ 50 oW

Some transforms require more than one input dataset. For example, to stack two tables, one

on top of the other:

o Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using cmd+click).

e Click the Stack transform button (you may need to scroll the Left pane to see the
button).
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N Easy Data Transform «1.4.0 {free trial)
DEEOQAQRQE rrwor
rrarsect [
o ®
Looiug @
@
@
@ ) testl.csv

v

ZZ cols u 64 rows

v test2.csv

23 cols x 18 rown

Subsract &)

testicsw

File:

Delimiter:
Encoding:

Igre;

[UsersfandyhiDeskiop/test].cev

watch file
Autamatic

Automatic

First O rowis)

has header

trim whitespace
simplify whitespace
ignare empty rows

Alias: test]
Carnmet:
c|m/z

tite  first rama  lastname  su
1 L Andrew  Adams
2 WS Mikki Adams
3 Ms Fose Arwell
4 M Colin Myt
5 Mrs  Michelle Slairg
6 Mr Simon  Blaire
7 Mr  Albert Brown
@ Mz Cynthéa  Brown
8 Miss Jane Brawn
10 M Dawid Burgess

B Email us

Show first Wrows [

Mix  display nama
Mr Andrew Adams
Mrs Nikki Adarms
Ms Rosa Atwell
Mr Colin Ayer
Mrs bichelie Blairg
Mr Simon Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr David Burgess

questionsfesdback

The tables are now stacked one on top of the other in a new dataset item. You can choose

to match the columns by Header name or Column number.

- [ ] Easy Data Transform «1.4.0 (free trial)
DBEO0QA® # @ rhHwoor

dwemszriot ()

@

@

Mew Cod @
Nurmn Format @
Pad @&
Biver [@)]
Remove Cols  (7) testl.csv
Rename Col l:;:' ) <

22 ol x 64 rows

Recrder Cols (7
Raplace @

Aow Mum (zf\.l

Stack

Sample @ 22 esis % B rows
Sart @

sacs @ test2.csv

Sareat [ o A

Stamp @

Stats @.

Subititute @&

@
summary ()
Total @

Transpose [0

Easy Data Transform

Stack

LT
wu

Align columns byd, Header name ) E

Comment:

Stack rows of all inputs. Orders by the vertical (Y] position

af the input dataseds.

G& A 5

Tithe
1 M
2 i
3 Ms
4 i
5 Mrs
L
T M
LI
9 Miss
WM

first rame | lastname  sul

Andrew  Adams

Nikdkci Adams
Rosa Avwell
Colin Ayer
Michelle Elaire
Simon  Blaire

Albart Brown
Cynthia  Brawn
dane Brown

David  Burgess

Last 72 rows not shawn

£ email us

mow fira1 10 rews [

Mix | display name

Mr Andrew Adarms
Mrs Milkki Adams
Ms Rose Atwell
Mdr Colin Ayer

Mrs Michelle Blaire
Mr Siman Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr Dvid Burgess

gquestionsifeedback
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Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input files will be automatically read in. Any changes to input datasets or
transform options will be automatically propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, or to view it in a local editor,
select the dataset item and click on the appropriate button in the Right pane.

Stack el

Align columns by: Header name H

Comment:
Stack rows of all inputs. Orders by the vertical () pusitinn'
of the input datasets.

([% B 7)) Show first 10 rows E,

You can also add an output item to automatically write a dataset to file whenever it

changes.
- [ ] Easy Data Transform «1.4.0 (free trial)
DBE0QA R H#E® rhHwoor
Hew Col @ Stack @[22
Hum Format "\3} : | ) ) Align columns by:  Header name H
Pad ':2-) Commaent:
Pivot 0] Stack rows of all inpuis. Orders by the vertical [Y) position
= of the input datasets.
Remove Cols {:::
Shiw Tirs1 10 rews
Rename Col 5 G [El .f " ﬂ
Peceder Cols .,‘2) tithe  first rame  lLastname  suffic  display name
S & . 1 Mr Andrew  Adams Mr Andrew Adarns:
testl.csv ke k]

M (—'} v 2 Mg Nikki Adams Mrs Milkki Adams
Samule @ e 3 Ms  Rose  Atwel s Rose Atwel
Saet ()] 4 Mr  Colin Ayer Mdr Colin Ayer
St Cad & Stack 5 Mrs  Michelle Blaire Mrs Michalle Blaire

"'k“ .
Soread [0 Y R & Mr  Simon [Bilaire Mr Siman Blaire
':' T M Albert Brown Mr Albert Brawn
Stamp @ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
P ” test2.csv
Stats (7 8 Miss Jane Brown Mrs Jane Brown
— & 22 coli x 18 rows
= W M David Burgess Mr David Burgess
Summar )
Y W Last 72 rows not shawn
Total @
Transpo sd L?:'

Teim

] Email us questions/feedback
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You will be asked for a file to write to. You can choose amongst multiple file formats. Select
CSV file.

Save As: output V
Tags:
Where: " andyb a

v CSV file (*csv)

Excel fileb{*.xlsx)

- [l [N Y [SE—

Your dataset will then be written to this file every time it changes.

- [ ] Easy Data Transform «1.4.0 (free trial)
DEEBAQARQHE® rwnn
. '::’:' output.csv @ :;1:
@ File: [Users/andyb/output.csv
@ Dalimiter: Comma () %]
@ Encading: UTF-B ™
@ . i . Values as:  Mod
(?} Byte Order Mark
@ Write mode:  Overwrite B8
@ Alias: output
® v testl.csv Comment:
(::". Lk (i & &2 Show first 10 rows B
@. tithi | TirE Al W) A SUMiE | dipli Rame
& Stack output.csv 1 Mr Andrew  Adams Mr Andrew Adams
| —d
'@ 23 cols x &Y rows 23 cols x B rows 2 Mz Mikki Adams Mrs Mikki Adams
@ 3 Ms  Rose  Atwell Ms Rose Atwed
(E’:' 4 Mr Colin Ayar Mr Colin A
yar
C8V
g v test2.cs ] ] . )
— & M Michelle Blaire Mrs Michelle Blaire
(.2) &3 coln x 18 rows
& Mr  Simon [Blaire Mr Siman Blaire
@
ToME o Albert Brown Mr Albert Brawn
o
@ 8 Mrs Cynthia Brown Mrs Cynthia Brown
7
"i) 9 Miss Jane Brown Mra Jane Brown
7
® Wl David Burgess Mr David Burgess
o Dutput
@ Last 72 rows not shown

= Email us questionsifeedback

You can also specify the delimiter and encoding for your CSV files in the Right pane.
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KA
N

output.csv @

File: /Usersfandyb/output.csy

Delimiter: Comma (,)

Encoding: UTF-8

Values as: MNodes
Byte Order Mark
Write mode: Overwrite

Alias: output

Comment:

You can save your transforms to a transform template document to use again with
File>Save.

Have a play!

Tips:

¢ You can also paste in data from the clipboard (for example, a table from a web page or
Word document).

e The Compare cols, Filter, If and Sort transforms take account of dates, numbers and text.
You can define what date formats to recognize in the Preferences window.

e New columns are always added to the right of a table.

e Comparisons of text are always sensitive to case, unless stated otherwise. E.g. "CASE",
"case" and "Case" are treated differently.

e Comparisons of text are always sensitive to whitespace (e.g. spaces and tabs), unless
stated otherwise. You can use the Trim transform to remove leading and trailing
whitespace.

e The contents of input and output data files are not saved in Easy Data Transform, only
their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key") column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

¢ You can perform the same set of transformation on multiple files using Batch processing
or command line arguments.

We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.

Easy Data Transform © 2020 Oryx Digital Ltd
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2 Reference

2.1 User Interface
2.1.1 Main window

The Main window comprises:
¢ Main menu
e Tool bar

o Left pane
o Center pane

¢ Right pane
e Status bar

Tool bar Left pane Center pane Right pane

- [ ] Easy [ta Transform «1.4.0 {free trial)

DEEOoQAQFEE rremon

- input output.csv 3|53
] -
FromFile () File: [Users/ancybjoutput, csy -
From Clioboard  (7) Delimiter:  Comma () %]
¥ Transform Encoding:  UTF-B =]
Al transtorms A Vil .
alugs as:  Nod
W2 Byte Order Mark
'f?:' Wirite mode:  Overwrite H
)] o bestl. cov Alias: output
.\’2’) B Commaent;
@ ~
\:\ o Stack " . Dedupe o, DUtpUL.CSY [N WP Show first 10 rews [
L / —— i — —— ile | first name |lastname  suMix | display name
@ ! i Mr Andrew  Adams Mr Andrew Adams
-  testZcsv
~ 2 Mrs  Mikki Adams Mrs Mikki Adams
(7
2 3 Mz Rose  Atwall M3 Rose Atwell
@
— 4 Mr  Colin Ayer Bdr Calin Ayer
&
= 5 Mrs Michelle Elaire Mrs Michelle Blaire
@
= 6 M Simon  Blaire Mr Sirmon Blaire
]
=y 7 M Albert Brown Mr Albert Brown
(2
@ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
T ) Email us questions/fesdback
Status bar Input Transform Output

2.1.2 Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what
is selected in the Center pane.

2.1.3  Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.
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2.14  Right pane
The Right pane shows details of any input, transform or output items you have selected in

the Center pane.

2.1.5 Preferences window

Check open previous file at start-up if you want to start with the last file opened.

Check give option to disable outputs when opening a file if you want the option to
disable any ouputs with write mode overwrite or append when you open a file, preventing
accidentally writing over existing files. Note that this check is never made when using the -
exit command line argument.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing. Setting the value to 0 is generally not
recommended, as this means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the option key while moving the mouse wheel to switch between
zoom and scroll. If Scroll direction: Natural is checked in your Mac Settings>Mouse then
the directions will be reversed.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to
choose a new font. You might prefer a monospaced (fixed width) font such as Monaco or
Courier New. Click Default to set it back to the operating system default.

Set supported date formats to the date formats you wish to recognize.

2.2 Input
2.2.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".
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Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters
e Excel .xIsx or .xlIs

Easy Data Transform will make an intelligent guess at the:

e column delimiter (e.g. comma) for CSV/TSV/text files

e text encoding (e.g. UTF-8) for CSV/TSV/text files

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing the Delimiter,
Encoding and has header fields in the Right pane.

You can select the input item in the Center pane and change any options related to the
output in the Right pane.

RA
testl.csv ¢

File: /Usersfandyb/Desktop/testl.csv
watch file

Delimiter: Automatic

Encoding: Automatic

< & @

Ignore: First 0 row(s)

has header

trim whitespace
simplify whitespace
ignore empty rows

Alias: testl

Comment:

Data will normally be read from the first non-blank line. Set Ignore if you want to ignore a
number of rows before you start inputting. Note that empty rows are counted.

Check watch file if you want the file to be automatically reloaded every time that Easy Data
Transform detects that it has been changed (which will then update everything

‘downstream’).

Check trim white space to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to replace any tabs or carriage returns within data values with
spaces.
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Check Ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Use Comment to record any notes that might be useful to a colleague or your future self.

2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform ‘upstream’ of it
changes.

Use Comment to record any notes that might be useful to a colleague or your future self.
2.3.2 Case
Description

Changes the case of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.
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¢ Set Change case to to Lower case (e.g. "text"), Upper case (e.g. "TEXT") or Title case (e.g.
"Text").

See also
e Trim
233  Chop

Description
Remove characters from the start or end in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e Whitespace is counted when calculating length. You can use Trim to remove whitespace
before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract

2.34 Clone

Description
Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.
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2.3.5 Compare Cols

Description
Creates a new column with a comparison of two other columns.

Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2.

Notes

e Number, date and text values are treated differently. Any values that can be converted to
a number will be treated as a number. Any values that match the supported date formats
in Preferences will be treated as a date. All other values are treated as text.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Trim to remove whitespace before filtering and Replace to get of other unwanted
characters (e.g. whitespace inside the text).

e The new column is added at the right end. You can change the column order with
Reorder Cols.

See also
e Split Cols
2.3.6 Concat Cols

Description
Creates a new column by concatenating text from one or more existing columns.

Inputs
One.

Options
e Check the columns you wish to concatenate.
e Supply the Delimiter you wish to place between concatenated text (optional). For

example *,".
e Check keep empty if you wish to keep the delimiter for empty columns.

Notes
e |f there is a header, the header of the new column is formed from the header of the
concatenated columns. You can Rename Cols it.
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e Concatenating a single column makes a copy of the column.
e The new column is added at the right end. The values are in the order of the columns.
You can change the column order before concatenation with Reorder Cols.

See also

e Split Cols
e Substitute

2.3.7 Copy Cols

Description
Creates one or more copies of the selected column(s).

Inputs
One.

Options
e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.

Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

238 Count

Description
Counts the number of occurence of each item of text in the selected column.

Inputs
One.

Options

e Select the Column whose values you wish to count.

e Set Sort by depending on whether you wish to sort alphabetically ascending by the Text
or numerically ascending by the Count.
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Notes
e Date and number values are treated as text.
e You can use the Sort transform to change the sort order from ascending to descending.

See also
e Pivot
e Stats

e Summary
2.3.9 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product' or 'cross join'.

Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e It can create a very large number of rows!

See also

2.3.10 Date Format

Description
Changes the date format in one or more columns.

Inputs
One.

Options

e Check the columns you wish to transform.

e Supply the existing date format in Format from (see below).

e Supply the new date format in Format to (see below).

¢ The following date formats are supported for input and output:
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Format Meaning

d The day as number without a leading zero (1 to 31)

el The day as number with a leading zero (01 to 31)

ddd The abbreviated localized day name (e.g. ‘Mon' to 'Sun’). Uses the system locale
to localize the name.

ceeel The long localized day name (e.g. 'Monday' to 'Sunday'). Uses the system locale
to localize the name.

M The month as number without a leading zero (1 to 12).

- The month as number with a leading zero (01 to 12)

MMM The abbreviated localized month name (e.g. 'Jan' to 'Dec'). Uses the system
locale to localize the name.

e The long localized month name (e.g. 'January' to 'December’). Uses the system
locale to localize the name.

vy The year as a two digit number (00 to 99).

yyyy The year as a four digit number. If the year is negative, a minus sign is
prepended in addition.

Notes

e You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.

Example
To change from "31/1/2019" to "01-31-19" set Format from to "d/M/yyyy" and Format to
to "MM-dd-yvy".

See also
e Num Format

2.3.11 Dedupe

Description
Remove duplicate rows.

Inputs
One.
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Options

e Check the column(s) you wish to look for duplicate values in.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns
selected.

e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Trim to remove whitespace before deduping.
e When several rows are duplicates, only the top one is retained.

Example
If you are cleaning up a mailing list, you might want to dedupe on the 'email’ column, after
converting all the emails to lower case.

See also
e Dedupe a dataset
2.3.12 Extract

Description
Extract a length of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the length you want values in selected columns shortened to.

e Set From to Start or End depending on whether you want to take from the start or end.

¢ |If From is Start then Offset is the offset of the first character from the start. If From is
End then Offset is the offset of the last character from the end.

Notes

e Whitespace is counted when calculating length. You can use Trim to remove whitespace
before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

See also
e Chop
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2.3.13 Fill

Description
Fill empty cells in selected columns with the next non-empty cell value above/left
(depending on direction of fill).

Inputs
One.

Options
e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill from.

Example
This is useful for filling in gaps in hierarchical tables. For example filling down the first two
columns:
Country 1 Area 1 City 1 Country 1 Area 1 City 1
City 2 Country 1 Area 1 City 2
City 3 * Country 1 Area 1 City 3
Area 2 City 1 Country 1 Area 2 City 1
City 2 Country 1 Area 2 City 2
2.3.14 Filter
Description

Removes rows based on number, date and text values in selected columns.

Inputs
One.

Options

e Click the '+' button to add a new filter criteria.
e Click the 'x' button to delete the selected filter criteria.
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e Select Keep if you want to keep matching rows and Remove to remove matching rows.

¢ Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

Notes

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Trim to remove whitespace before filtering and Replace to get of other unwanted
characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

2.3.15 Gather

Description
Gather multiple columns into new key and value columns. Also called a long pivot or group

by.

Inputs
One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

¢ Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Example

salesman area QIUIGZINIGaNNGE
1 Alice North 11.3 893 443 18

2 Bob East 45 79 8 2z
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With columns Q1, Q2, Q3 and Q4 gathered:

Gather Q)
EI '::':l. Filter columns

salesman

kA
Jlew

area
o1
Q2
Q3
Q4

4 of 6 columns selected

(<J Q< J<

Key column name: Quarter

Value column name: Amount

Comment:
Gives:

salesman area Quarter Amount
1 Alice North Q1 11.3

2 Alice North E 89.3

3 Alice North Q3 443

4 Alice North H 18

5 Bob East Q1 45

6 Bob East H 79

7 Bob East Q3 8

8 Bob East H S
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Notes
e New columns are added at the right end. You can change the column order with Reorder
Cols.
e You can merge the value and key columns into a single column with Concat Cols.
e The opposite of Gather is Spread.
23.16 If

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Inputs
One.

Options

e Click the "+IF' button to add a new IF/ELSE IF..THEN condition.

e Click the '+AND' button to add an AND to the selected IF/ELSE IF.. THEN.
e Click the 'x' button to delete the selected IF/ELSE IF.. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

Notes
e You can simulate OR with multiple IF statements. For example:

IF x = 10R vy =2
THEN 3

Is equivalent to:

IF x = 1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.
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e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Trim to remove whitespace before filtering and Replace to get of other unwanted
characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also

e Lookup
2.3.17 Insert

Description
Append/prepend text to one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e In Insert put the text you want to insert.

¢ In At put the position you want the text inserted.

Notes
e You can use Trim to remove whitespace before inserting.

See also
e Pad
e Extract

2.3.18 Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.
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Notes

e Easy Data Transform will try to guess sensible default values for Top key column and
Bottom key column based on column header names and contents.

e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Trim to remove whitespace before the intersect.

e Does not remove duplicates. You can use Dedupe to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract

2.3.19 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle numbers, dates and text.

Inputs
One.

Examples
To multiply the value in column 'items' by the value in column 'item price"

return $(items) * $(item price);

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' + first;

To calculate the biggest of columns 'v1' and 'v2"

return Math.max ( $(vl), $(v2) ):
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To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+12[(12[0-9]1{3}[)]12[-\s\.12[0-91{3}[-\s\.1?2[0-91{4,6}S$/;
if ( validPhoneNum.test( $(phone num) ) )

return "valid";
else

return "invalid";

To calculate the number of years difference between dates in column 1 and column 2:
return new Date( $(1) ).getFullYear() - new Date( $(2) ).getFullYear();

To calculate the number of whole days difference between a date in the 'created’' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) / ( 1000*60*60*24 ) );
To reverse the text in the 'key' column:

var newString = $(key);

for (var 1 = a.length - 1; 1 >= 0; i--) {
newString += al[il;

}

return newString;

Options

e Enter your script into the Javascript field. The script should be the body of a Javascript
function.

e Select a column from Insert variable to add that variable into the Javascript field at the
current cursor position.

e Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors.

Notes

¢ You can reference column values by their name (e.g. $ (item cost) for the 'item cost'
column) or index (e.g. $ (1) for the first column). The column name is case sensitive. You
will get a warning if more than one column has the same name.

e The Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have

been made without the Evaluate button being clicked.

o The item upstream of it changes.
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e Javascript may not recognize numeric values containing commas (e.g. '1,234') as numeric.
But you can use the Replace transform to remove commas from numeric column before
processing the Javascript transform.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

¢ Any errors from the Javascript engine are shown in a message window when Evaluate is
clicked.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
UTC. Date() is the current date.

¢ Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd') format,
e.g. '2020-01-31" (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should Join
them first.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.

e Javascript running in Easy Data Transform is not 'sandboxed’ and has the same privileges
as the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

2.3.20 Join

Description
Join two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs.

Inputs

Two.

Example
Joining these two datasets by the ID column in each:
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Name ID DOB ID Department Level
lﬁn Black 001 1966-0?& 1601 Engineering 1)
2 Paul White 002 1973-03-11 2|003 Engineering 2

3 Barry Green 003 1977-12-30 I 3|004 Marketing 1

oY

Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
Q0 %

i

IEKJETE'UPE D05 1981-[!3-_{})

Gives:

Mame 1D DOB Department Level

1 dgf:n Black Gﬂl\mﬁﬁ-ﬂ?ﬁﬁgineering 1\

2 |Paul White | 002 1973-03-11 Sales 2
3|Barry Green{ 003 [1977-12-3( Engineering 2

4)ane Brown| 004 [L980-11-03 Marketing 1

(%]

wTaupe @31981—{139 Sales 3

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input (a 'left join’).

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Select Include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input (a 'right join').

Notes

e Easy Data Transform will try to guess sensible default values for Top key column and
Bottom key column based on column header names and contents.

¢ All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Trim to remove whitespace before the intersect.
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¢ Use Concat Cols to join several columns together (e.g. ‘first name' and ‘'last name'
columns) to form a key column.

e Use Row Num to create a unique key column.

e Cascade multiple joins to join more than 2 datasets.

customers.csy |
o

1l &ds ¥ fowd

Join
W
A4 mux 130 mws

orders.csv
+

14 4K N B30 el

ordar-details.
o

Join

Jooe N ITmowE
FF oom w20 el

suppliers.csv
v
0% oo B e Join

51 &5 x 2.3k mwd

See also
e Cross
e Stack

e Lookup
e Merge datasets

2.3.21 Lookup

Description
Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.

Inputs

Two.

Example

If you have one dataset with category IDs and another dataset with category IDs and
category names, you can create a new category name column in the first dataset by looking
up the category ID in the second dataset.

First dataset:
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ProductlD ProductName SupplierlD CategorylD
11 Chai 1 1
12 |12 Chang 1 1
3 3 Aniseed Syrup 1 2
!4 4 Chef Anton's Cajun Seasoning 2 2
5 5 Chef Anton's Gumbo Mix 2 2

Second dataset:

CategorylD |CategoryName Description
1)1 Beverages Soft drinks coffees teas beers and ales
22 Condiments  Sweet and savory sauces relishes spreads and seasonings
33 Confections Desserts candies and sweet breads

Lookup transform:

products.csv

4 cols x 77 rows

v Lookup

5 cols x 77 rows

categories.csv

3 cols x8 rows
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Lookup

Top lookup column:  CategorylD
Bottom Lookup column: CategorylD

Bottom value column: CategoryMame

(O OR O R R
P Ol W

Bottom values used: First

Value if not found:

Comment:
Result:
ProductlD ProductName SupplierlD CategorylD Lookup CategoryName

11 Chai 1 1 Beverages

2 |2 Chang 1 1 Beverages

3 3 Aniseed Syrup 1 2 Condiments

4 4 Chef Anton's Cajun Seasoning 2 2 Condiments

5|5 Chef Anton's Gumbo Mix 2 2 Condiments
Options

¢ Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.

e Select Top lookup column for the column whose values you wish to lookup.

¢ Select Bottom lookup column for the column that matches the lookup in the bottom
dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Bottom values used to First if you want use the first match in Bottom lookup
column and All if you want to use all matches.

¢ Set Value if not found to the value you want to set for values in Top lookup column
that do not exist in Bottom lookup column.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column and
Bottom lookup column based on column header names and contents.

e Bottom values used is only important if there are duplicates in Bottom lookup column.

o If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Trim to remove whitespace before the intersect.
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e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

See also
o |f

oin

Col

—

2.3.22

2
()
3

Description
Adds a new column, filled with a given value.

Inputs
One.

Options
¢ Set New column value to the value for every cell of the new column. You can leave it
blank for an empty column.

Notes
¢ New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Copy Cols
e Remove Cols

2.3.23 Num Format

Description
Change the number format in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted).

¢ The following number formats are supported:
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Format Meaning

€ Format as [-]9.9e[+]|-]999.
E.g. 1234567.89 is shown as 1.235e+06.
E Format as [-]9.9E[+]-]999.

E.g. 1234567.89 is shown as 1.235E+06.
Format as [-]9.9.

E.g. 1234567.89 is shown as 1234567. 89.

g Use e or f format, whichever is the most concise
Use E or f format, whichever is the most concise

Notes
¢ Non-numerical values are ignored.
e You can also use Extract and Pad to change the number of characters.

See also
e Date Format
2.3.24 Pad

Description
Pad text to a minimum length in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

e Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Trim to remove whitespace
before padding.
2.3.25 Pivot

Description
Creates a pivot table to summarise values for one or two columns.
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Inputs
One.

Options

¢ Use Pivot column to select the column values you want to use as columns in your pivot
table.

e Use Pivot row to select the column values you want to use as rows in your pivot table.

e Use Pivot sum to select which column you wish to sum.

Notes
e Pivot tables are very useful for analysing data.
¢ Any non-numerical values in the Pivot sum column are ignored.

See also
e Count
e Stats

e Summary
2.3.26 Remove Cols

Description

Removes columns.

Inputs
One.

Options

e Uncheck the column(s) you wish to remove.

Notes
e The column will be removed from any dataset ‘downstream’.

See also
e New Col

2.3.27 Rename Col

This transform is deprecated. Use Rename Cols instead.

Description
Rename a column header.
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Inputs
One.

Options
e Select the column header you wish to rename in Column.
¢ Set Rename to to the new column header name.

Notes
e The names of column headers do not have to be unique.
2.3.28 Rename Cols

Description
Rename column headers.

Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names in the New name column to lower case.

¢ Click Upper to change all the names in the New name column to upper case.

e Click Title to change all the names in the New name column to title case.

e Click Reset to change all the names in the New name column back to their original name.

Notes
e The names of column headers do not have to be unique.

2.3.29 Reorder Cols

Description
Reorder columns.

Inputs
One.

Options

Drag the columns into the desired order (left-most at the top).
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Notes
You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.

2.3.30 Replace

Description
Replace text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Choose whether to use text or Regular expression matching.
¢ In Replace put the text you want to replace.

¢ In With put the text you want to replace it with.

Notes
e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Trim to remove whitespace before replacing.

Example
You can turn 0123456789 into (+44) 1234 56789 using a Regular expression:

Match type: Regex H
Replace: O(\d\d\dyd)(\d\d\d\d\d)
With: (+44)\1\2

See also
e |nsert
e Substitute

2.3.31 Row Num

Description
Add a new column that contains the row number.

Inputs
One.
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Options

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

¢ set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

2.3.32 Sample

Description
Selects a subset of rows from the input.

Inputs
One.

Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

Notes
e If you are transforming a large dataset, then you can use Sample to test a small subset.

2.3.33 Sort

Description
Sorts rows by one or more columns.

Inputs
One.

Options

e Click the '+' button to add a new sort level.

¢ Click the 'x' button to delete the selected sort level(s).

e Click the up arrow to move the selected sort level(s) up.

e Click the down arrow to move the selected sort level(s) down.

¢ Set Column to the column you want to sort by.

e Set Order depending on whether you want to sort this column Ascending or
Descending.
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Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for comparison purposes.

e Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Trim to remove whitespace before filtering.

2.3.34  Split Col

Description
Creates one or more new columns by splitting text at delimiters in a selected column.

Inputs
One.

Options

e Select the Column you wish to split.

e Supply the Delimiter you wish to use to split the column.

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to honor delimiters with nothing in between.

¢ set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes

e If no Delimiter is supplied then no new columns are created.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

See also
e Concat Cols

2.3.35 Spread

Description
Spread a column into multiple new columns. Also called a wide pivot or crosstab.
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Inputs
One.

Options

¢ Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.
Example

salesman area Quarter Amount

1 Alice North Q1 11.3

2 Alice North H 89.3

3 Alice North Q3 443

4 Alice MNorth E 18

5 Bob East QI 4.5

6 Bob East H 79

7 Bob East Q3 8

8 Bob East E S

With Quarter and Amount columns spread:

Spread @52
Key column: Quarter H
Value column: Amount a

Gives:
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salesman area QITIQ2NIQ3 G4
1 Alice North 11.3 893 443 18

2 Bob East 45 79 8 2

Notes

o If there are rows that are duplicates, apart from the value column, this will cause errors.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

¢ You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

2.3.36 Stack

Description
Stack the rows from inputs, one on top of the other.

Inputs

One or more.

Example
Stacking these two datasets by the ID column in each:

MName DOB
John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

Mame 1D DOB

Jane Brown 004 03/11/198

|
|
! Jill Taupe 005 01/03/198

Gives:
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Name ID DOB
1@_:1 Black 001 1966—3?@

2[Paul White 002 1973-03-11

3 @r}f Green 003 19??—12-_59

4 Jane Brown 004 1980-11-02\

SlillhTaupe 005 1981-03-[_}})

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id' column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched case insensitive (e.g. 'id' to 'ID"), if no case sensitive
match is possible.

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e If you align by Column number the header of the first input is used.

See also

e Cross

e Join

e Merge datasets
23.37 Stamp

Description
Adds a time/date stamp as a new row or a new column.

Inputs
One.

Options

e Supply the processing date/time format in Format (see below).
Format Meaning

d The day as number without a leading zero (1 to 31)
dd The day as number with a leading zero (01 to 31)
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Format Meaning

ddd The abbreviated localized day name (e.g. ‘Mon' to 'Sun’). Uses the system locale
to localize the name.

cldclel The long localized day name (e.g. '‘Monday' to 'Sunday'). Uses the system locale
to localize the name.

M The month as number without a leading zero (1 to 12).

— The month as number with a leading zero (01 to 12)

MMM The abbreviated localized month name (e.g. 'Jan' to 'Dec’). Uses the system locale
to localize the name.

. The long localized month name (e.g. 'January' to 'December’). Uses the system
locale to localize the name.

Yy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year is negative, a minus sign is prepended in
addition.

h The hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display).

ol The hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display).

H The hour without a leading zero (0 to 23, even with AM/PM display).

i The hour with a leading zero (00 to 23, even with AM/PM display).

m The minute without a leading zero (0 to 59).

e The minute with a leading zero (00 to 59).

S The whole second without a leading zero (0 to 59).

Ss The whole second with a leading zero where applicable (00 to 59).

z The fractional part of the second, to go after a decimal point, without trailing
zeroes (0 to 999). Thus "s.z" reports the seconds to full available (millisecond)
precision without trailing zeroes.

AP or A

The fractional part of the second, to millisecond precision, including trailing.
ap or & Use am/pm display. a/ap will be replaced by either "am" or "pm".
The timezone (for example "CEST").

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.
2.3.38 Stats

Description
Add a row with the average, minimum or maximum of numeric values in one or more
selected columns.
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Inputs
One.

Options

e Check the column(s) you wish to add stats for.

Notes
e The average is the arithmetic mean.
¢ Non-numerical values are ignored.

See also

e Count

e Pivot

e Summary
2.3.39 Substitute

Description
Substitute column values into text.

Inputs
One.

Example
To create SQL statements to insert 'Country’, 'Year', 'Key' and 'Value' column values:

INSERT INTO mytable (Country, Year,Key,Value) VALUES ($(Country),$(Year),$(Key),$ (Value
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Substitute I s

New column name: SQL

Substitution script:

INSERT INTO mytable(Country,Year,Key,Value) VALUES (5(Country),S(Year),$(Key), ${Value));

Insert variable: <select> H Evaluate

Comment:

Substitute column values into text.

L& 7
Country Year Kay Value SQL
1 Afghanistan 1999 cases 745 INSERT INTO mytable(Country,Year Key,Value) VALUES (Afghanistan,1999,cases, 745);
Options

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that variable into the Substitution script
field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row.

Notes

e You can reference column values by their name (e.g. $ (item cost) for the 'item cost'
column) or index (e.g. $ (1) for the first column). The column name is case sensitive. You
will get a warning if more than one column has the same name.

e The transform is calculated every time:
o The Evaluate button is pressed.
o The Substitute transform item is unselected in the Center pane and script changes

have been made without the Evaluate button being clicked.

o The item upstream of it changes.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.
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2.3.40 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

e Easy Data Transform will try to guess sensible default values for Top key column and
Bottom key column based on column header names and contents.

e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Trim to remove whitespace before the subtract.

e Does not remove duplicates. You can use Dedupe to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Intersect

2.3.41 Summary

Description
Summarise the values in the selected columns.

Inputs
One.

Options

e Select the Columns you wish to summarise.

e Check check for dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.
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Notes

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

¢ Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

¢ Unique values is the number of unique values in the column. Empty values are not
counted. Date and numeric values are treated as text (e.g. '7' is treated as different to '7.0'
and '1/1/2020" is treated as different to '01/01/2020"). Comparison between values is
sensitive to case and whitespace.

¢ Min length is the minimum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Max length is the maximum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Min numeric is the minimum numeric value in the column.

¢ Max numeric is the maximum numeric value in the column.

¢ Min date is the minimum date value in the column. Only shown if check for dates is
checked.

¢ Max date is the maximum date value in the column. Only shown if check for dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

e You can use Trim to remove any whitespace at the start or end of values before Summary.

e If you wish to have a row displayed per column you can Transpose the table.

See also

e Count

e Pivot

e Stats
2.3.42 Total

Description
Add a new column with a running (cumulative) total of the selected column.

Inputs
One.
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Options

¢ Set Column to the column you want to total.

Notes

e Non-numerical values are ignored.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Count

e Pivot

e Stats
2.3.43 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Inputs
One.

Options

e Check has header to make the new first row into a header (requires >1 row).

Notes

e If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

e Datasets with very large numbers of columns can be slow to display.

2.3.44 Trim

Description
Removes leading and trailing whitespace from one or more columns.

Inputs
One.
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Options

e Check the column(s) you wish to transform.

See also
e Case

2.4 Output
24.1 Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

o Excel

» JSON

e HTML

e Markdown

e ISV

e vCard

o XML

* YAML

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the file
type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.

output.csv E :

File: /Usersfandybfoutput.csy

Delimiter: Comma (,) H
Encoding: UTF-8 e
Values as: MNodes
Byte Order Mark
Write mode: Overwrite H
Alias: output

Comment:
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Set File to the location of the file you want to output. If you are writing to a .xls or .xIsx file
the output will be written to a sheet called 'Easy Data Transform'.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Encoding to the text encoding you wish to use (only available for delimited text files).

Set Values as depending on how you want to structure the output (only available for XML
files).

Set Byte Order Mark checked write a Unicode Byte Order Mark to the file (only available
for UTF encodings).

Set Write mode to:

‘Disabled' not to write to the file.

'‘Overwrite' to create a new file (if none exists) or overwrite (if the file exists).
'‘Append' to create a new file (if none exists) or append to it (if the file exists).
'‘New' to create a new file (if none exists) or do nothing (if the file exists).

Use Comment to record any notes that might be useful to a colleague or your future self.

2.5 File formats

Enter topic text here.

2.5.1 CSV format

Easy Data Transform can input from and output to CSV format files. File extension ".csv".

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. Carriage return denotes the end of a row. The
column delimiter is usually commas, but not always.

Easy Data Transform supports the following column delimiters:
e comma (,)

semi-colon (;)

colon ()

pipe (|)

caret ()
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For all the above delimiters:

e If a value field contains a quote (") character, then the quote will be ‘escaped’ by an
additional quote when output.

e If a value field contains a delimiter, quote or carriage return character, then the value be
surrounded by quotes (") when output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:

CategoryID, CategoryName, Description,In stock
1,Beverages, "Soft drinks, coffees & teas", true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

Tab delimited (TSV) files are treated a bit differently.

2.5.2 Excel format

Easy Data Transform can input from and output to Excel ".xIsx" and ".xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

2.5.3 JSON format

Easy Data Transform can output to JSON format files. File extension ".json".

JSON (JavaScript Object Notation) format is commonly used for exchanging data between
programs.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

"CategoryID": 1,

"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": true

"CategoryID": 2,

"CategoryName": "Condiments",
"Description”: "Sweet and savory sauces",
"In stock": false

"CategoryID": 3,

"CategoryName": "Confections",
"Description”: "Candies and sweet breads",
"In stock": true

254  HTML format
Easy Data Transform can output to tables in HTML format files. File extension ".html".
HTML (HyperText Markup Language) format is commonly used for creating web pages. If

you don't need the data to take up a whole page, you can just copy the <table> to
</table> part of the output.

For example:
| CategorylD CategoryName Description In stock
‘ 11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
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Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-align:left;vertical-align:top;bord
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

2.5.5 Markdown format

Easy Data Transform can output to tables in Markdown format files. File extension ".md".

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true

1212 Condiments Sweet and savory sauces false

|

I

| 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock |
| === [ === [ == e e e | —========= |
|1 | Beverages | Soft drinks, coffees & teas | true
| 2 | Condiments | Sweet and savory sauces | false
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

2.5.6 TSV format

Easy Data Transform can input from and output to TSV format files. File extension ".tsv".

TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format. Values are separated by tab characters. Tabs are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

If you have a tab character in a value, Easy Data Transform will convert it to a space on
output.

2.5.7 vCard format

Easy Data Transform can output to vCard format files. File extension ".vcf".
VCard format is commonly used as way of exchanging contact details between programs.

Note that you need to change the column header names to the values expected by vCard
(using the Rename Cols transform).
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For example:
N FN ORG TELTYPE=WORKVOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;
Is output as:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest;;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK, VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of America
END:VCARD

2.5.8 XML format

Easy Data Transform can output to XML format files. File extension ".xml".

XML (Extensible Markup Language) format is commonly used for exchanging data between

programs.
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output with Values as set to Nodes as:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
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<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>

Is output with Values as set to Attributes as:

<?xml version="1.0" encoding="UTF-8"?>

<root>
<record CategoryID="1" CategoryName="Beverages" Description="Soft drinks, coffees &
<record CategoryID="2" CategoryName="Condiments" Description="Sweet and savory sauc
<record CategoryID="3" CategoryName="Confections" Description="Candies and sweet br

</root>

2.5.9 YAML format

Easy Data Transform can output to YAML format files. File extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2

CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3
CategoryName: Confections
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Description: Candies and sweet breads
In stock: true

2.6 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.

testl.csv e

File: /Usersfandyb/Desktop/testi.csv
watch file

Delimiter: Automatic

Encoding: Automatic

- & @

Ignore: First O row(s)
has header
ace
simplify whitespace
ignore empty rows

Alias: testl
Comment:
Cl B & Show first 10rows [
Gitle first name  last name  suffix  display name >
1 Mr Andrew  Adams Mr Andrew Adams

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

2.7 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

transactions.x...

Y, Filter

35 cols x 53.3k rows b 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

¢ Select Edit>Delete (or click the Delete tool bar button).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

Filter

transactions.x...

%)

lick to connect from this item.

35 cols x 53.3k rows

e Hover over the end item
e Click the '+' that appears.

Filter

transactions.x...

35 cols x 53.3k rows lick to connect to this item.

Press the 'Esc' key or click away from an item to cancel adding the connection.
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Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.

2.8 Text
Whitespace (such as Space and Tab characters) and capitalization are always significant,

unless stated otherwise.

You can remove leading and trailing white space by checking trim whitespace in the Input
or using the Trim transform.

You can change the case using the Case transform.
2.9 Dates

Set the date formats you want to recognize in the Preferences window using the following
format.

Format Meaning

d The day as number without a leading zero (1 to 31)

o The day as number with a leading zero (01 to 31)

ddd The abbreviated localized day name (e.g. 'Mon' to 'Sun'). Uses the system locale
to localize the name.

cclelel The long localized day name (e.g. ‘Monday' to 'Sunday'). Uses the system locale
to localize the name.

M The month as number without a leading zero (1 to 12).

= The month as number with a leading zero (01 to 12)

MM The abbreviated localized month name (e.g. 'Jan' to 'Dec'). Uses the system
locale to localize the name.

—— The long localized month name (e.g. ‘January' to 'December'). Uses the system
locale to localize the name.

Yy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year is negative, a minus sign is prepended
in addition.

For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy
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Note that dates with only two year digits, are treated as a date between 1900 and 1999. E.g.
"31/1/19" is interpreted in d-M-yy format as 31st January 1919.

Values that are in a recognized date format will be treated as dates in the Filter, If and Sort
transforms. Supporting large numbers of date formats will slow down these transforms.

You can also change the format of dates using the Date Format transform.

2.10 Numbers

Easy Data Transform uses the locale set on your computer to decide what is a number. For
example, if your system locale is set to US or UK then "123.45" is a number and "123,45"
isn't, and vice versa if your system locale is Germany or France.

2.11 Regular expressions

Easy Data Transform allows the use of regular expressions in the replace, if and filter
transforms.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match type: Regex H
Replace: (\w+)\s*(\w+]
With: \2, \1
Turns:
Full name

1 John Smith

2 Mary Brown

3 Jill Jones
Into:
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Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.regular-expressions.info and regexr.com.

2.12 Batch processing

To apply the current transform template file to multiple input files select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.

orders.csv

v

14 cols x 830 rows

Join output.json

v v/

24 cols x 830 rows

24 cols x 830 rows

customers.csv

11 cols x 91 rows

®0®

Batch Process

Input columns can inglude wildcards and Exdgl sheet names:

E.g. '/Users/andyb/Dbcuments/*.csv' or 'fUsery/andyb/Documents/data.xIsx[*]".
Qutput columns cannclude: {customers}, {ordyrs}, {date}, {time}, {datetime}:
E.g. '/Users/andyb/Dbcuments/{customers}_{datgtime}.csv'

Click "Help’ for more Hetails.

Add Remoje Clear

Input alias=customers Input alias=orders Qutput alias=output (Overwrite)

1 pbox/northwind/customers.csv | .. indyb/Dropbox/northwind/*.csv | .. |pfmergedfoutput_{anrs}.json

wildcard Input file name
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Note:

¢ All input and output items must have an alias.

e An output item can't have the same alias as another output or input item.
e Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.
Click Remove to remove the selected processing row(s).
Click Clear to remove all processing rows.

In the (pink) input column you can use * and ? wildcards for file name stems, file extensions
and Excel sheet names. E.g.:

Input Description

/Users/andy/Documents/*.csv || files with extension .csv in the Documents folder

/Users/andy/Documents/d?.csp|| the files with name 'd plus a single character in the
Documents folder

/Users/andy/Documents/data.p|| the sheets in data.xlsx in the Documents folder

/Users/andy/Documents/*.x1sA|| the sheets beginning with 'data’ in all the .xslx files in
the the Documents folder

Note:

e If there is more than 1 input column that specifies multiple files or sheets, then an output
will be created for each possible permutation of input files/sheets in the row. E.g. 3 input
files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders.

In the (green) output column you can use the following variables to create your output file
name:

Output Meaning Example

variable

{<input alThe name of the input file being If input alias 'orders' is using file
processed in the column with the

corresponding alias.

Date processing was carried out in2020_04_18

year_month_day format
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{time} Time processing was carried out in15_21_56_599
hours_minutes_seconds_millisecon
ds format

tdatetime} pate/Time processing was carried 2020_04_18_15_21_56_599
out in

year_month_day_hours_minutes_s
econds_milliseconds format
format

Whether an ouput file is created, overwritten or appended to depends on the Write mode
of the output item.

Click Process to start processing the rows.
Click Stop to stop processing the rows.
Click Close to close the window.

See also:

e Batch processing examples
e Command line arguments

2.13 Command line arguments

Easy Data Transform accepts the following command line arguments:

<file narThe transform file to open at start-up.

—eli Close the application once any processing on the opened file is complete.

~file <algets the input or output file with the given alias to the location (path) specified.
Input Excel files should include the sheet name, e.g. file.xlsx[sheet].

~verbose Qutput additional information to the terminal.

This allows you to process .transform files in batch mode, e.g.:

/Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docu
/Bpplications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docu

You can also use the Mac 'open’ command:

open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile\ 1.trans
open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile2.transfo

But note that no command line output is shown if you use 'open’.

Put single quotes (') around any arguments with spaces or a backslash (\) in front of each
space (as shown in the examples above).
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To do this on a schedule, call a script file from a scheduling program, such as launchd.

See also:
e Batch processing

2.14 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses Input
file MyData.csv in sub-folder Mypata (C:\Users\andy\Documents\Data\MyData.csv).

e mytransform.transform iS moved t0 /Users/Bob/Documents/EDT on a Mac.

e When mytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e |f it can't find that it will look for Mypata.csv in sub-folder MyData
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't

recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.
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3 How do I?

3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

EA
testl.csv v

File: /Usersfandyb/Desktop/testl.csv
watch file

Delimiter: Automatic

Encoding: Automatic

- B B

Ignore: First O row(s)
has header

ace
simplify whitespace
ignore empty rows

Alias: testl
Comment:
C % 559 Show first 10 rows H
Gitle first name | last name | suffix  display name >
1 Mr  Andrew Adams Mr Andrew Adams

3.3 Change a connection
To change a connection see connections.
3.4 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.
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EA
testl.csv ¢

File: Jtrunk/help/data for screen caps/testl.csv

watch file
Delimiter: Automatic H
Encoding: Automatic E

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv @ E :

File: fUsersfandyb/output.csy

Delimiter: Comma (,) H

Encoding: UTF-8

3.5 Dedupe a dataset

If you want to remove duplicate entries from a dataset, use the Dedupe transform. For
example, to remove the 2 rows that have the same email from this dataset:

| First Last Email

|1J.A. Black jablack@gmail.com

'2 Paul White p.white@hotmail.com

3 Barry Green bareen@aol.com

4 Jane Brown Jb3423@gmail.com

5. Taupe taupeB89759@gmail.com

16 John Black jablack@gmail.com

7!B. Green bgreen@aocl.com

To get this dataset:
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First Last Email

1 JA. Black jablack@gmail.com
2 Paul White p.white@hotmail.com
3 Barry Green bgreen@aol.com

4 Jane Brown Jb3423@gmail.com

51. Taupe taupe89759@gmail.com

Drag the dataset file onto the Center pane of Easy Data Transform.

\/mailing xlsx[S...

3 cols x 7 rows

Select the dataset then click the Dedupe transform in the Left pane.

v;nailing.xls.x[s... Dedupe

v/

3cols x7 rows 3cobk x7 rows

Check Email in the Right pane to remove rows with duplicate emails.

Dedupe @I |5
E 'Q Filter columns

title
first name

]

(< J < J < |

last name

Only the first row with a particular email is kept. Use Sort if you want to change the order
before removing duplicates.

If you only want to remove rows with the same last name and same email, check both Email
and Last checkboxes.
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Note that de-duplicating columns takes account of whitespace and case. So you might need
to do Trim and Case transforms before the dedupe.

3.6 Handle large datasets

Large datasets (e.g. a million data points or more) can slow down updates. So we
recommend you add a sample transform straight after the input and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can
then change the sample transform to pass through all rows.

3.7 Merge datasets

Easy Data Transform has two options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:

Name DOB
John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977

MName DOB
Jane Brown 004 03/11/198

|
|
! Jill Taupe 005 01/03/198

To get this dataset:
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Name ID DOB
1 ﬁlv'l_n Black 001 1966-07-01

2[Paul White 002 1973-03-11

3 @r‘y Green 003 19??—12—_5’}[}/

4 Jane Brown 004 1980-11-02\

Sli!lhTaupe 005 1981—03—[_}})

Drag the two dataset files onto the Center pane of Easy Data Transform.

datasetl.xlsx|...

3 oolsx 3rows

dataset2.xlsx]...

3 cols x 2 rows

Select the two datasets using cmd +click then click the Stack transform in the Left pane.

datasetl.xlsx[...

3 wlsx Irows

Stack

3 colsx Srows

v

dataset2.xlsx[...

3 cols x 2 rows
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The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the the vertical positions of the
datasets to change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

Name ID DOB ID Department Level
lﬁn Black 001 1966-0?3\ 601 Engineering 1)

=

| ]
[

Paul White 002 1973-03-11 003 Engineering 2

3 Barry Green 0031 1977-12-30 I 3|004 Marketing 1

b

Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
Q0 %

L]

IS\JllTaupe 005 1931—[!3—_{})

By common ID value to get this dataset:

Name ID DOB Department Level
1 ﬂg;n Black Ifalllil\'LE!EEr'ClI"h"('Filr'mg;irmeerinlg 1 )

2|Paul White | 002 [1973-03-11 Sales 2
3|Barry Green{003 [1977-12-3(} Engineering 2

4|Jane Brown| 004 1980-11-03 Marketing 1

(%]

[ﬂTaupe @31931-{139 Sales 3

Easy Data Transform © 2020 Oryx Digital Ltd




How do I?

Drag the two dataset files onto the Center pane of Easy Data Transform.

datasetl.xlsx|...

3 mlsx 3Irows

dataset2.xlsx]...

3 cols x 2 rows

Select the two datasets using cmd +click then click the Join transform in the Left pane.

datasetl.xlsx]|...

3 cols ¥ S rows

Join
v4
5cols x5 rows

dataset2.xlsx]...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.
The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the the vertical positions of the datasets to change the

order in which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.
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Set Include top non-matching rows and Include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.

Note that matching columns takes account of whitespace and case. So you might need to
do Trim and Case transforms before the join.

3.8 Move a.transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Finder. You either leave the Input files at the original location or move them to the same
location relative to the .transform file (e.g. if they were in the same folder as the .transform
file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location
relative to the .transform file (e.g. if they were in the same folder as the .transform file
before, move them to the same folder as new .transform file).

See also .transform files.

3.9 Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.
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3.10

L L ] Easy Data Transform v1.4.0 {free trial)
DBEE Q@ Q # & rrHwor
Mew Col @ Stack 3|52
Wum Format (B ’ : . : Align columns by:  Header name <]
Pad @ Comment:
Aivot ()] S1ack rows of all inputs. Orders by the vertical (¥) position
_ of tha input datasers.
Remove Cols (7))
: | ) ) Show firs1 10 rows
Aenamecol  (7) Gk & i B
Racrder Cols ® tithe: first rama  last name suffix  display nama
P @ ) 1 M Andrew  Adams Mr Andrew Adams
testl.csv ik ik
Ficwr Hum (-,) . o 2 Mrs  Mikki Adams Mrs Hildki Adams
Sampie ) R 3 Ms Rose Atwall Mz Rose Atwel
Sort @ 4 Mr  Colin Ayer Mr Colin Ayer
St Cal & Stack 5 Mz Michelle Blaire Mrs Michalle Blaire
H-{‘ .
Foread [ » I3 eols x BE rows & Mr Simon Blaire Mr Simon Blaire
@ T M Albert Brown Mr Albart Brown
ftwmp @ 8 Mz Cynthia  Brown Mrs Cynthia Brown
s P Y test2.csv
s 9 Miss Jane Brown Mrs Jang Brown
Sutnsiue -@ 42 cols x LA rows
- 0 W David  Burgess Mr David Burgess
@

=
Summar ¥
Y i Last 72 rows not shown
Todal @
Tanspose  (7)

Teifm

[ Email us questions/fesdback

e Select *.xlIsx or *.xls from the file type drop-down list that appears.

« CSV file (*csv)

- Excel file (%xis)

P £ ok ke )

Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
Processing or command line arguments.

Example 1
To convert a folder full of .csv files to .json files:

1. Select File>New to create a new transform template file

2. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.
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testl.csv output.json

v v

22 cols x 64 rows 22 cols x 64 rows

4. Select File>Batch Process.
5. In the Batch Process window change the .csv file name to *.csv and output.json to
output {testl}.json.

- ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. '/Users/andyb/Documents/*csv' or 'fUsers/andyb/Documents/data.xIsx[*]"

Qutput columns can include: {test1}, {date}, {time}, {datetime}: r
E.g. '/Users/andyb/Documents/{test1}_{datetime}.csv'

Click "Help' for more details.

Add Remove Clear

Input alias=test1 Qutput alias=output (Overwrite)

1 fUsersfandyb/Desktop/=csv jUsers{andybfoutput_{test‘l}ljscn

Process Stop

6. Press the Process button. A .json file will now be created for each .csv file in the folder.

If you want to process input files from another folder then click Add to add a new row and
change the test1 input folder.

Example 2
Merge multiple .csv files into a single .csv file:

7. Select File>New to create a new transform template file

8. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.
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9. Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.

testl.csv

J merged.csv

v

22 cols x 64 rows 22 cols x 64 rows

4. Set Write Mode to Append in the Right pane.

KA
"}

merged.csv ©)

File: /Usersfandyb/Desktop/merged/merged.csv

Delimiter: Comma (,)

(O O

Encoding: UTF-8

Values as: Modes
Byte Order Mark

Write mode

Alias: merged

5. Select File>Batch Process.
6. In the Batch Process window change the input .csv file name to *.csv.
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@ ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. ‘/Users/andyb/Documents/*.csv' or '/Users/andyb/Documents/data.xlsx[*]"
Output columns can include: {test1}, {date}, {time}, {datetime}:

E.g. ‘/Users/andyb/Documents/{test1}_{datetime}.csv"

Click 'Help' for more details.

Add Remove Clear

Input alias=test1 Output alias=merged (Append)

1 [Usersfandyb/Desktop/*.csv - | [Usersfandyb/Desktop/merged/merged.csv

Process Stop

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other .csv files. If merged.csv already exists, you may need to
delete it first.

If the headers are different orders in different .csv files, then you can Stack by header name
to get a consistent column order before outputting.

colum n-order....

S cols x 1 rew

Stack

merged.csv
J g

27 cols x6S rows 27 @ls x 65 rows

testl.csv

22 cobs x Bdrows
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Stack o

Align columns by( Header name ) H

Comment:

You can use a Filter transform on the output to remove any repeated headers.
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Support
4.1 Contact support

If you have any questions or suggestions, please contact us at
support@easydatatransform.com .

4.2 Report abug

Please report any bugs you find to support@easydatatransform.com and we will attempt to
fix them. Please include:

e a description of the bug

e your operating system (e.g. Windows 10)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e a screen capture can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.
4.3 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please email us at support@easydatatransform.com .
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